Tobii® Technology

Tobii TX300
Eye Tracker

Revision 2
On Safety

Read this manual carefully before connecting and using the eye tracker

The Tobii TX300 Eye Tracker is intended only for use in office environments.

Do not open the eye tracker!

Non-compliance will result in loss of Warranty! There are no user serviceable components inside and the risk of electric shock is high due to the presence of Dangerous High Voltages. Contact Tobii support if your eye tracker is not working properly.

The eye tracker contains a lithium battery. CAUTION! Risk of explosion if battery is replaced by an incorrect type. If battery is replaced or the eye tracker is discarded, dispose of used batteries according to the battery instructions.

Epilepsy warning

Some people are susceptible to epileptic seizures or loss of consciousness when exposed to certain flashing lights or light patterns in everyday life. Such people may have a seizure while watching certain images or patterns on a monitor. This may happen even if the person has no medical history of epilepsy or has never had any epileptic seizures.

Declaration of Conformity

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules, EMC directive 2004/108/EEC and RoHs 2002/95/EC. The product also conforms with the directive 2006/95/EEC for low voltage.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy, and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

The following standards have been used:

- Canadian ICES-003 Issue 4: Digital apparatus, Class B.

All Tobii Eye Trackers are CE-marked, indicating compliance with the essential health and safety requirements set out in European Directives.

The Tobii Eye Trackers are for use in office environments.
Legal information

Tobii TX300 Eye Tracker User Manual

This document contains information proprietary to Tobii Technology AB. The contents are confidential and any disclosure to persons other than officers, employees, agents or subcontractors of the owner or licensee of this document, without the prior written consent of Tobii Technology AB, is strictly prohibited. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, without the prior consent of the copyright holder.

Manual release 2.0, December 2014

Tobii Technology AB reserves the right to change the content of this manual without any prior notice. Changes due to typographical errors, inaccuracies or modifications in programs and/or equipment may be implemented at any time. Please check the Tobii web site www.tobii.com for updated versions of this document.

All rights reserved.

© Tobii Technology AB
# Table of Contents

## Quick Start - Integrated screen setup
- First time usage: 1
- Component checklist: 2

## Quick Start - Standalone
- First time usage: 3
- Component checklist: 3

## Product Care
- Assembling the TX300: 4
- Attaching the Allen wrench to the foot of the eye tracking unit: 7
- Changing from an integrated screen setup to a standalone setup: 7

## Connecting Tobii Eye Tracker
- Setting up the connection to your computer: 8
- Installing the USB to LAN adapter: 8
- Installing eye tracker software: 8
- Setting up the network connection to the eye tracker in Windows: 9
- Connecting to the eye tracker in Tobii Studio: 11
- Connecting to the eye tracker when using the Tobii SDK: 11

## Configuration and Settings
- General setup guidelines: 12
- X Configuration Tool: 13
- Accessing the X Configuration Tool: 13
- Setting parameters in the X Configuration Tool: 13
- Measuring the Active Display Area: 14
- Measuring point on the TX300: 14
- Measuring the distance to the display or calibration grid: 15
- Measuring the horizontal angle of the eye tracker: 15
- Measuring the vertical angle of the display or calibration grid: 16
- Measuring the height difference between the display and eye tracker: 16
- Using a setup with side offset: 17
- Using a setup with angle offset: 17
- Saving the configuration: 18

## Integrated screen setup examples
- Basic setup with the integrated screen: 19
- Local Live Viewer setup with the integrated screen: 19
- Tobii E-Prime® setup with the integrated screen: 20

## Standalone eye tracker setup examples
- Scene camera setup (tracking real objects or surfaces): 22
- TV setup/Projector setup/External Video setup: 24

## Parts and Controls
- Equipment list: 26

## Customizing the Eye Tracker's Display
- OSD menu: 28
- Navigating the menu: 28
- Screen image Menu: 28
- Color Temperature User Menu: 28
- Screen Geometry Menu: 29
- Pip (picture in picture) Menu: 29
- OSD (on-screen display) Menu: 29
- System Menu: 30
- Information Menu: 30
- Input Source Selection Menu: 30

## Summary of OSD menu when connected via DVI
- 31

## Summary of OSD menu when connected via VGA
- 32
Quick Start - Integrated screen setup

Step 6. First time usage

1. **Configure the network card**
   Configure the built-in network card in your computer, your network router, or your office LAN. Read more on pages 8-10.

2. **Install the eye tracker software**
   Install Tobii Studio or Tobii Eye Tracking Tools. Read more on page 8.

3. **Mount the eye tracking unit on a table**
   Ensure the eye tracker is placed on a flat surface. Read more on page 6.

4. **Detach the cover from the eye tracker**
   Detach the cover from the eye tracker and place the cover in the flight case. Read more on page 6.

5. **Attach the screen to the eye tracker**
   Attach the screen to the eye tracker. Read more on page 7.

6. **Connect the eye tracker to your computer**
   Connect the Power, DVI and LAN cables and turn on the eye tracker by pressing the system ON/OFF button. When the eye tracker is on, a blue light will light up on the eye tracking unit's system ON/OFF button. Press the Source button on the screen to choose the input mode (Digital). See figures on the left. If needed, connect the user camera and speaker. Do not forget to remove the plastic protection film from the user camera before first use. Read more on pages 8-11.

7. **Reboot your computer**

8. **Connect the eye tracker to Tobii software**
   Start Tobii Studio or other supported software and make sure the eye tracker is connected. Read more on page 11.

9. **Adjust your physical setup and enter the parameters in the X Configuration Tool**
   Adjust the physical setup of the eye tracker and other devices. Open the X Configuration Tool, select the T setup option and save the selection to the eye tracker. Note: No measurements are needed when using an Integrated screen setup. Read more on page 13.

10. **Create your Project and Tests in Tobii Studio or other supported software**
    Read more in the Tobii Studio User Manual.

11. **Calibrate and record in Tobii Studio or other supported software**
    Read more in the Tobii Studio User Manual.

⚠️ When you turn off the eye tracker unit by pressing the system ON/OFF button, **DO NOT HOLD DOWN THE BUTTON FOR MORE THAN 2 SECONDS**. Pressing the button for more than 2 seconds will force the system to shut down and risk system memory corruption.
Component checklist

- Tobii TX300 Eye tracking unit
- TX300 Screen unit
- Computer with Tobii Studio or other supported software
- Tobii Studio or Tobii T/X Series Eye Trackers Resources CD
- Power supply cable for the Eye tracking unit
- Power supply cable for the Screen unit
- DVI-D cable
- LAN cable
- USB - LAN Adapter
- Audio Cable
- User Camera USB Cable A/B
Quick Start - Standalone Setup

First time usage

1. **Configure the network card**
   Install and configure the separate USB Ethernet adapter, configure the built-in network card in your computer, your network router, or your office LAN. Read more on pages 8-10.

2. **Install the eye tracker software**
   Install Tobii Studio or Tobii Eye Tracking Tools. Read more on page 8.

3. **Mount the eye tracker on a table**
   Ensure the eye tracker is placed on a flat surface. Read more on page 6.

4. **Connect the eye tracker to your computer**
   Connect the Power cable and the LAN cable and turn on the eye tracker. When the eye tracker is on, a blue light will light up on the eye tracking unit's system ON/OFF button. If needed, also connect the speaker cable. Read more on pages 8-11.

5. **Reboot your computer**

6. **Connect the eye tracker to Tobii software**
   Start Tobii Studio or other supported software and make sure the eye tracker is connected. Read more on page 11.

7. **Adjust your physical setup and enter the parameters in the X Configuration Tool**
   Adjust the physical setup of the eye tracker and other devices, measure all the required parameters and enter them in the X Configuration tool. Save the parameters to the eye tracker. Read more on pages 14-18.

8. **Create your Project and Tests in Tobii Studio or other supported software**
   Read more in the Tobii Studio User Manual.

9. **Calibrate and record in Tobii Studio or other supported software**
   Read more in the Tobii Studio User Manual.

Component checklist

- Tobii TX300 Eye tracking unit
- Computer with Tobii Studio or other supported software
- Tobii Studio or Tobii T/X Series Eye Trackers Resources CD
- Power supply cable
- LAN cable
- USB - LAN Adapter
- Audio Cable
# Product Care

<table>
<thead>
<tr>
<th><strong>Temperature and humidity</strong></th>
<th>Do not place the eye tracker in places subject to extreme temperatures and humidity, such as on top or near a heating element, or in a damp room.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Do not expose the eye tracker to direct sunlight. Failure to comply may lead to equipment damage due to high temperature exposure.</td>
</tr>
<tr>
<td></td>
<td>The recommended range of temperatures and humidity values are:</td>
</tr>
</tbody>
</table>
|                             | **Storage temperature:** -20°C to +70°C / -4°F to 158°F  
**Storage humidity:** Max. 70%, no condensation  
**Usage temperature:** 0°C to +35°C / 32°F to 95°F  
**Usage humidity:** Max. 80%, no condensation |
| **Placement**               | Only use arms and stands specified by the supplier and make sure that they are mounted and fastened correctly according to the instructions. Do not place the eye tracker on unstable and uneven surfaces. |
|                             | Avoid places subject to strong mechanical vibrations or shock. The eye tracker is not intended for mobile use. |
|                             | Do not cover the ventilation openings of the eye tracker. If these openings are covered, heat build-up may cause failure and a possible fire hazard. |
| **Ingress protection**      | IP class 20. No protection against objects smaller than 3.5mm. |
|                             | Do not place the monitor in places with large amounts of dust, dirt or sand, for example, near an open window or an outdoor exit. |
|                             | If setting up temporarily in an outdoor location take adequate precautions against airborne dust and dirt. |
|                             | Do not use the eye tracker near water. The eye tracker is not water resistant. |
| **Mechanical shock**        | If the eye tracker is exposed to mechanical shock, for example, when dropped, do not try to connect it to a power source. Contact Tobii support. |
| **Power**                   | It is recommended that you connect the power cable of the eye tracker and computer to an outlet with a protective earthing connection. |
|                             | Use an accessible outlet and make sure that the cables are properly placed to avoid a possible trip hazard. |
|                             | Do not try to replace, repair or bypass a blown fuse. A blown fuse is an indication that there is a malfunction in the eye tracker, contact Tobii support to arrange for your equipment to be serviced. |
| **Transportation**          | Disconnect all the cables and grasp the monitor with both hands when carrying it. |
|                             | When you transport the eye tracker for repair, shipment or traveling, use the original casing and packing materials. |
| **Cleaning**                | Before cleaning the eye tracker’s monitor unplug the power cord from the power outlet. Only use products intended for screen cleaning. Avoid dripping liquids into the openings between the screen surface and the chassis as the eye tracker may be seriously damaged. |
| Eye tracker setup | For full functionality and best performance use computers that fulfill the Minimum System Requirements and third party equipment from the System Recommendations document (available for download at www.tobii.com).

Make sure the network connection is set up according to the description in this manual.

Always ensure that the eye tracker is turned off, i.e. that the blue light on the system ON/OFF button is not lit, before disconnecting the eye tracker from the power supply. |
| Disposal of the eye tracker | Do not dispose of the eye tracker in general household or office waste. Follow your local regulations for disposal of electrical and electronic equipment. |
Assembling the TX300

The TX300 can either be used with its supplied screen unit or as a standalone eye tracker. In the following instructions, the setup used with the screen will be called an integrated screen setup and a setup where the eye tracking unit is used separately will be called a standalone setup.

Assemble the stand and the eye tracking unit

1. Assemble the stand and the eye tracking unit
   Place the eye tracking unit upside down on a table or other flat surface. Align the holes in the eye tracker with the screws attached to the stand. Fasten the screws. If needed, tighten the screws using the supplied Allen wrench.

2. Assemble the foot and the stand
   Place the foot on the stand. Align and fasten the screws attached to the foot to the holes in the stand. Tighten the screws using the supplied Allen wrench.

   Note: The TX300 is delivered in the flight case with the top plate attached. Therefore, for first time use in an integrated screen setup, the top plate has to be removed.

Remove the top plate

1. Prepare the eye tracker unit for the assembly
   Place the eye tracking unit on a flat surface. Angle it slightly backwards.

2. Loosen the screws
   Loosen the black screws, as seen in the image to the left, with the supplied Allen wrench.

3. Remove the top plate
   Remove the screws and the top plate. Place the top plate in the flight case.

   Note: To attach the top plate, complete this process in reverse.
Step 2. Attach the screen unit

1. Attach the screen unit

Prepare the eye tracker unit for the assembly

1. Place the eye tracking unit on a flat surface. Angle it slightly backwards. Remove the top plate if it is attached to the eye tracking unit by removing the five screws seen on the bottom left image on the previous page.

2. Place the screen unit

Slide on the screen unit so the front of the screen unit hooks into the holes at the top front of the eye tracking unit. Place the screen so the holes in the screen unit align with the holes in the eye tracking unit. Hold on to the screen unit until the screws are fastened enough to ensure the screen unit cannot fall off.

3. Attach the screen unit

Ideally, attaching the screen unit is done by two persons: one who holds the screen unit in place and one who fasten the screws. Fasten the black screws supplied with the eye tracker in the holes as seen in the image to the left while you hold on to the screen unit. Once all screws have been fastened, use the supplied Allen wrench to tighten the screws.

Note: The same screws are used both to fasten the top plate and the screen unit.

Step 3. Attach the screen unit

Attach the Allen wrench to the foot of the eye tracking unit

Underneath the foot of the eye tracking unit is a small, plastic holder for the Allen wrench. After first time assembly, attach the Allen wrench to the holder. Keeping the Allen wrench in the holder prevents it from getting lost.

Changing from an integrated screen setup to a standalone setup

In order to use the eye tracker in a standalone setup, the screen provided with the eye tracker has to be removed. In addition, if the eye tracker has been used in a standalone setup and now should be used in an integrated setup, the top cover has to be removed before attaching the screen. The instructions below describes how to change from an integrated screen setup to a standalone setup.

1. Place the eye tracker on a flat surface

Ideally, detaching the screen unit is done by two persons: one who holds the screen unit in place and one who removes the screws. Angle the unit so the screen is close to vertical. Position yourself in front of the screen. Hold the screen unit with one hand while you remove the screws with the other in order for the screen unit not to fall off when all screws have been removed.

2. Remove the screws that attaches the screen to the eye tracking unit

Use the supplied Allen wrench to remove the screws. Place the screws in the flight case.

3. Remove the screen

Remove the screen and place it in the flight case.

4. Attach the top plate to the TX300 Eye Tracker

Place the top plate on the area of the eye tracker previously covered by the screen and attach it using the black screws provided with the eye tracker.

5. Adjust your physical setup and enter the parameters in the X Configuration Tool

Adjust the physical setup of the eye tracker and other devices, measure all the required parameters and enter them in the X Configuration tool. Save the parameters to the eye tracker. Read more in the chapter ‘X Configuration Tool’.
Connecting Tobii Eye Tracker

Setting up the connection to your computer

The eye tracker communicates with the computer via a standard network cable. Connect the eye tracker to your computer using the LAN cable (LAN).

Connect the eye tracker directly to the built-in network card in your computer. The network card must be configured in Windows to obtain an IP address automatically (see instructions on next page). Windows will say limited connectivity for the eye tracker LAN connection. This is correct, so the warning that will appear by the network connection icon can be ignored. Please note that if you connect the eye tracker directly to the built-in network card in your computer you won’t be able to access the Internet unless you use an additional network card or a wireless network.

Installing the USB to LAN adapter

If you want to use the provided USB to LAN adapter to equip the computer with an extra network connector, start the setup by installing the USB to LAN adapter on your computer. Having an extra network connector can be useful if wanting to connect to the internet or a local network at the same time as having the eye tracker connected. However, the USB to LAN adapter should not be used to connect the computer to the eye tracker. Plug the USB cable into an available USB port on your computer. If running Windows Windows 7, the computer will detect new hardware and automatically install the drivers for you. If running Windows XP or Windows Vista you will be prompted for the drivers, which can be found on the separate CD provided. Please follow the on-screen instructions. For detailed instructions on driver installation, please refer to the network adapter manual on the CD.

Installing eye tracker software

Install Tobii Studio, Tobii SDK or other supported eye tracking software on the computer you intend to use. If Tobii Studio is to be used, ensure it is version 2.2.x or higher. Please refer to the Tobii Studio Manual or Quick Start Guide for more information.

Installing Tobii Eye Tracking Tools

If you install Tobii Studio 2.2.x or later on your computer, the Tobii Eye Tracking Tools are installed automatically. If Tobii Studio is not to be used, the installation file for the Tobii Eye Tracking Tools can be found on the CD provided with the eye tracker. The installation file is called tobi-eye-tracking-tools-X.msi (where X is replaced with the version number of the software). After installing the Tobii Eye Tracking Tools you can browse for the eye tracker by going to Start > All Programs > Tobii > EyeTracker Browser.
Setting up the network connection to the eye tracker in Windows

The network card in Windows must be configured to obtain an IP address automatically. On most computers this is the default setting. Please follow the instructions below to configure the network card.

**In Windows XP**

1. Open the Windows Control Panel
2. Open Network Connections. Right click on the network card you will be using to communicate with the eye tracker. Choose Properties.
3. Select Internet Protocol (TCP/IP) then click on the Properties button. See image to the left.
4. Make sure that Obtain an IP address automatically is selected in the Internet Protocol (TCP/IP) Properties window. See image to the left.
5. Click OK to close the windows and apply the settings.
6. Plug in the eye tracker to the network card you just configured and reboot your computer. Ensure the eye tracker is powered on before rebooting the computer.

Windows will say limited connectivity for the eye tracker network connection. This is correct, ignore the warning.

**In Windows Vista**

1. Open the Windows Control Panel
2. Open Network and Sharing Center
3. Click on the View Status link next to Local Area Connection (see image below). The Local Area Connection Status dialog box will open.
   - Under “This connection uses the following items”, click Internet Protocol Version 4 (TCP/IPv4), and then click on the Properties button. See image to the left.
4. Make sure that Obtain an IP address automatically is selected in the Properties window. See image to the left.
5. Click OK to close the windows and apply the settings.
6. Plug in the eye tracker to the network card you just configured and reboot your computer. Ensure the eye tracker is powered on before rebooting the computer.

Windows will say limited connectivity for the eye tracker network connection. This is correct, ignore the warning.
In Windows 7:

1. Open the Windows Control Panel
2. Open Network and Sharing Center
3. Click on the Local Area Connection link next to Connections: (see image below). The Local Area Connection Status dialog box will open.

4. Click on the Properties button.
5. Click ‘Yes’ in the dialog window that appears. This action requires an Administrator account on the computer. Consult your system administrator regarding local computer user permissions.
6. Under “This connection uses the following items”, click Internet Protocol Version 4 (TCP/IPv4), and then click on the Properties button.
7. Make sure that Obtain an IP address automatically is selected in the Properties window.
8. Click OK to close the windows and apply the settings.
9. Plug in the eye tracker to the network card you just configured and reboot your computer. Ensure the eye tracker is powered on before rebooting the computer.

Windows will say limited connectivity for the eye tracker network connection. This is correct, ignore the warning.
Connecting to the eye tracker in Tobii Studio

The computer is connected to the Tobii TX300 Eye Tracker in Tobii Studio using the instructions below. Before using this part of the guide, Tobii Studio or the Tobii Eye Tracking Tools has to be installed.

The first time Tobii Studio is opened it is possible to select the Tobii TX300 Eye Tracker from the list of connected eye trackers as the eye tracker connection window will appear automatically. After that it has to be opened manually by following the instructions below. If you are accessing this connection window automatically as when starting the software for the first time, go to step 3 below.

1. Start Tobii Studio by clicking the icon on your desktop.
2. Open an existing project or create a new project and test.
3. On the Design and Record tab, click Setup and select Settings…. This will open the Global Settings dialog box.
4. Select the Eye Tracker tab and click the eye tracker in the eye tracker list.
5. Verify that the eye tracker is connected by checking the Status value corresponding to the eye tracker in the list.
6. Click OK to close the Global Settings window.
7. If there are problems in connecting to the eye tracker or if the connection appears slow, try to reboot your computer.

A status indicator below the Recording button in the Tobii Studio Design & Record view shows if the eye tracker is connected or not. Click on the status indicator to open the Eyetracker Selector window.

Connecting to the eye tracker when using the Tobii SDK

The eye tracker is connected by setting the IP address in Tobii SDK applications or other supported software. If Tobii Studio is not installed on your computer you must first install the Tobii Eye Tracking tools to be able to access and configure the eye tracker. The installation file called tobii-eye-tracking-tools-X.msi (where X is replaced with the version number of the software) can be found on the CD provided.

To open the Tobii EyeTracker Browser go to the windows Start > All Programs > Tobii > Tobii EyeTracker Browser. In the Tobii EyeTracker Browser window, all detected eye trackers are listed.

1. **Select** the eye tracker to be used for testing. The hostname is shown in the information part of the window. This name is similar to the serial number of the eye tracker.
2. Click on the Copy button to copy the eye tracker hostname.
Configuration and Settings

**General setup guidelines**

The distance from the person's eyes to the eye tracker should be approximately ~65 cm (26"). If the eye tracker is too close or too far away from the test subject there is a risk of losing some of the gaze data.

When the TX300 is used in a standalone setup, it should be placed **below the screen** (or the surface that is to be studied) without covering the bottom of the screen for the person watching the stimuli.

The eye tracker should be placed so that the gaze angle will not exceed ~35° to any point on the **screen (or other stimuli used)** (see images).

It is very important to have the **correct distance** to the screen, or the tracked object. Otherwise the eye tracker cannot track the entire area. If the screen or object is placed too close to the eye tracker there is a risk that the gaze data for the corners of the screen will not be collected (see image to the right). The correct distance can be calculated by using basic trigonometry and including the gaze angles and the screen size.
The Tobii TX300 Eye Tracker can be used in many different situations. For example, it can be used with any monitor or used to perform eye tracking relative to a physical scene, a TV, or a projection screen. For all this to work, the user must provide some information to the TX300 eye tracker about the physical setup. This is done using the **X Configuration tool**.

TX300 can be used both with the provided screen (integrated screen setup) and without the screen (standalone setup). It can even be used with a screen other than the provided screen. However, if any other screen than the screen provided with the eye tracker is used, it must be configured as a standalone setup.

### Accessing the X Configuration Tool

The X configuration tool is either installed when installing Tobii Eye Tracking tools or when installing Tobii Studio. To open the X Configuration Tool go to Windows **Start > All Programs > Tobii > Tobii EyeTracker Browser**. Or in Tobii Studio go to **Global Settings: Tools > Settings > Eye Tracker**.

Click on the TX300 Eye Tracker in the list and thereafter on the **X Config Tool...** button.

**NOTE:** Even if the TX300 is used in an integrated screen setup, it must be specified in the X configuration tool. However, in that case only the tick box in the top right corner of the light gray area needs to be ticked and no other measurements made.

### Setting parameters in the X Configuration Tool

When the TX300 is used with its provided screen, i.e., in an *integrated screen setup*, the only setting that needs to be made in the X configuration tool is ticking the tick box labelled **Use in T-mode** (see image below).

When using a *standalone setup* the user must always specify all the positioning parameters included in the X Configuration tool. These are:

- Eye tracker angle
- Distance to screen
- Screen angle
- Active Display Area
- Height difference between screen and eye tracker

Please be as careful and precise as possible when measuring the required parameters in your setup. All parameters can have both positive and negative values. The values can be added both as centimeters and inches. How to set up the different parameters will be described on the following pages.
Measuring the Active Display Area

The correct screen or stimuli size must always be added in the X configuration tool. For computer monitors, televisions and other displays, measure the size of the **visible active area** on the screen, where you can see the actual image (see the top image to the left).

For projected screens, measure the size of the visible projection on the screen (see the bottom image to the left). In a scene camera setup the active display area must be calculated based on the calibration grid size. Read more about the calibration grid in the scene camera setup chapter.

Measuring point on the TX300

All distance measurements should ideally be made from a point on the TX300 stand. The point is marked on the stand by a '+'-sign (the red circle in the image below). This point remains constant even if the angle of the TX300 is changed. In addition to the measuring point on the stand, there is also a line on the foot plate indicating from where horizontal distances can be measured (see the dotted circle in the image below).
Measuring the distance to the display or calibration grid

Measure the distance from the measuring point on the foot of the TX300 (see image to the left) to the front of the active display on the monitor, projection screen, or TV screen, or in a scene camera setup to the virtual screen (25% larger than the calibration grid). If the measuring point on the TX300 is located behind the active display, enter a negative distance (use - in front of the value).

Always make sure that the distance to the active display is long enough for the eye tracker to track the entire area. Please read the General Setup Guidelines on page 17 for more information.

Measuring the horizontal angle of the eye tracker

Calibrate the digital angle gauge supplied with the TX300 before measuring the angle between the eye tracker and the horizontal plane. To calibrate the digital angle gauge, place it on a flat, horizontal surface and press the ‘Zero’ button. Measure the exact angle between the horizontal plane and the eye tracker body using the supplied digital angle gauge.

Place the digital angle gauge on top of the eye tracker (see images below to the left). In many setups the angle is usually around 30 degrees.
Measuring the vertical angle of the display or calibration grid

Measure the angle between the vertical plane and the active display. In a scene camera setup measure the angle between the vertical plane and the calibration grid used.

If the display is tilted forwards you should enter a negative angle (use - in front of the value). If the active display is completely vertical the angle value is 0. In a scene camera setup where you want to track objects on a horizontal table the angle would be 90 degrees.

Measuring the height difference between the display and eye tracker

Measure the height difference between the measuring point on the TX300 and the bottom of the active display area. Always use the visible active display as described in the 'Measuring the active display area' chapter.

In a scene camera setup measure the height difference between the bottom of the virtual screen (which is 25% larger than the calibration grid) and the measuring point on the TX300 (see image to the left). If the active display is located below the measuring point on the TX300, for example in a projector setup, the value will be negative. Enter the value in the X configuration tool with a - in front to signify it as a negative value.
Using a setup with side offset

If the Eye Tracker is not placed right in front of the screen with the axis horizontally aligned, an offset can be entered in the X Configuration tool (called Side offset).

In this case check the Use Side Offset check box and enter the side offset from the center of the active display to the center of the eye tracker, enter a negative value if the eye tracker is located to the left of the center as seen from the front.

Using a setup with angle offset

The eye tracker should be placed parallel with the screen or tracked object. If this is not the case you should check the Use Rotation check box and enter the angle between the back of the eye tracker and the active display. If the eye tracker is rotated clockwise (opposite as shown in the picture), enter a negative angle.
Saving the configuration

When using different setups it is useful to save the different configurations locally on your computer. This gives you the possibility to go back and reuse the configuration for the specific setup. The file can also be used as a local backup for your configuration in case the settings need to be adjusted later.

Configurations can be saved and loaded in the Configuration tool.

A Click **Save To File** to save the configuration as .xcfg file locally on your computer.

B Click **Load from File** to load a saved .xcfg configuration.

C To start using the configuration entered in the tool, you must click **Save to Eyetracker**. The parameters will then be sent to the eye tracker and the eye tracker will immediately be properly configured. When any parameter in the tool is changed the button must be pressed again for the eye tracker to get the new settings.
Integrated screen setup examples

Basic setup with the integrated screen

This basic setup is the simplest setup when using on-screen stimuli, such as images, movies, web or software. The image above illustrates the single screen setup. The eye tracker is connected to the computer via the computer’s LAN connector and a DVI cable (Recommended) or VGA cable (Not recommended). To create a portable lab, replace the computer in the setup drawing with a laptop or shuttle computer.

Local Live Viewer setup with the integrated screen

This setup is used when the test is to be supervised from a screen next to the eye tracker setup where the moderator can see the eye movements of the subject in real time during testing. When using the Tobii TX300 Eye Tracker in this setup, configure Windows to use the eye tracker’s screen as the primary screen. For this option the graphics card in the computer must support dual output. To create a portable lab, replace the computer in the setup drawing with a laptop or shuttle computer.
**Tobii E-Prime® setup with the integrated screen**

The Tobii extensions for E-Prime® offer a set of native E-Prime® objects tailored for the Tobii eye tracking system. These offer functions on two different levels:

- **TET level** - In this mode, E-Prime® controls the Tobii Eye Tracker processing unit directly, without using Tobii Studio at all. E-Prime® performs calibrations, collects gaze data and saves this to file.

- **Tobii Studio level** - In this mode, E-Prime® remote controls Tobii Studio. Timing is synchronized between E-Prime® and Tobii Studio, data is collected by both E-Prime® and/or Tobii Studio. In this mode, Tobii Studio can be used for data visualization and analysis.

Even though it is possible to run E-Prime® and Tobii Studio on the same computer, it is recommended to run the E-Prime® software on a separate computer, which communicates with the Tobii Eye Tracker processing unit and Tobii Studio software over TCP/IP. A video capture card can be used to capture a video of the stimulus presented by E-Prime® in Tobii Studio for visualizations and post-recording analysis.

**One-computer setup**

![Diagram](image.png)

The E-Prime® software and Tobii Studio software are run on the computer and communicate with the Tobii Eye Tracker Server over a LAN network (TCP/IP protocol). Tobii Studio is used to calibrate the participant, whereas the E-Prime® is used to display the stimulus and record the eye movement data. A secondary screen can be added to the setup to enable the eye tracker operator to monitor the progress of the trial during the recording.
Two-computers setup

In a two-computer setup you will use Tobii Studio to record the gaze data and E-Prime® to present the stimulus. The E-Prime® software and Tobii Studio software are run on two different computers and communicate with the Tobii Eye Tracker Server as well as between each other over a LAN network (TCP/IP protocol).

The image from the Tobii Studio computer has to be displayed on the Tobii Eye Tracker’s display during calibration (to display the calibration points), whereas the E-Prime® computer should be shown on the Tobii Eye Tracker’s display during the actual test. Therefore, both computers have to be connected to the Tobii Eye Tracker’s display. Two secondary screens can be added to the setup to enable the eye tracker operator to monitor the progress of the trial during the stimulus presentation and recording.

The image or video presented by E-Prime® on the eye tracker’s display also has to be recorded by Tobii Studio and synchronized with the gaze data. The image or video recording is done via a video capture card installed on the Tobii Studio computer. As a result, the display output of the E-Prime® computer needs to be split in two connections: one to the eye tracker’s display and another to the video capture card on the computer running Tobii Studio.

For more information about E-Prime®, please visit www.pstnet.com.
Scene camera setup (tracking real objects or surfaces)

Real objects, like magazines etc. can be used as stimuli in a scene camera setup where a video camera is filming the object during the recording. In this setup the calibration points cannot be displayed on a screen during the calibration, thus a separate calibration grid must be used. The grid can be drawn on a paper and include five or nine points. The object you intend to track should fit within an area which is 25% larger than the actual calibration grid. Always make sure that the eye tracker is able to track the person’s eyes over the entire calibration grid. During the calibration procedure the person is asked to look at the corresponding points in the grid.

All values in the X Configuration Tool must be measured and added correctly to ensure accurate data (see the chapter about the X Configuration Tool). Additionally a calibration image (see image from Tobii Studio below) from the scene camera must be specified in Tobii Studio (see how in the Tobii Studio manual).

The eye tracker is always calibrated against a two-dimensional surface, and all eye tracking data is in two dimensions. If eye tracking is to be done on three-dimensional objects, parallax errors will be induced. To minimize these errors always set up the scene camera overlooking the calibration area from an angle as close as possible to that of the person being eye-tracked.
The **Active Display Area** (parameter in the X Configuration Tool) in a scene camera setup is always 25% larger than the size of the actual calibration grid. The stimulus you intend to track should always fit within this area. The calibration grid must have the same shape as the calibration pattern used in Tobii Studio and include either five or nine points. The calibration points can be drawn on a paper, marked on a calibration board, or marked on objects in the scene. It is also good to include the 25% larger Active Display Area (see below) around the grid to make it easier to measure the parameters required in the X Configuration Tool. Make sure that the corners of the calibration grid are exactly 90 degrees and that the center point is exactly in the middle of the grid. How to calculate the 25% larger Active Display Area, which needs to be added in the X Configuration Tool is described below:

\[
\text{Active Display Area Height} = 1.25 \times \text{Calibration grid height}
\]
\[
\text{Active Display Area Width} = 1.25 \times \text{Calibration grid width}
\]

The 25% larger virtual screen (Active Display Area) is used also when specifying the other parameters in the X Configuration Tool, like distance from the eye tracker to the screen and the height difference between the eye tracker and the screen. See images below.

Eye calibration of a person is done with the **manual calibration** procedure in Tobii Studio. The person conducting the study has to manually step through the calibration points by asking the person in front of the eye tracker to look at the first calibration point, and when he does so, press the space bar. Then have him look at the second calibration point, and so on.
In a TV or projector setup, always make sure the eye tracker is able to track the eyes over the entire screen by using the correct distance to the screen, and the correct tilt angle of the eye tracker. For more information regarding the correct distance, refer to the chapter ‘General setup guidelines’. The TX300 Eye Tracker should be placed as high up as possible without covering the bottom of the screen from the person watching it. A setup including a TV or projector can be realized in two different ways:

**Computer will display stimulus on the TV or projector screen**

You will use the computer for displaying the stimulus on the screen, for example by using Movie stimulus in Tobii Studio. In this setup the computer must support a video out option so that the screen can be used as an additional screen connected to the computer. Configure Windows to use the TV or projector as the primary display. An additional optional secondary monitor can be used for monitoring the eye movements during the recording by using the Live Viewer function in Tobii Studio.
The stimulus presented on the screen is generated by an external device such as a DVD player, set top box, gaming console etc. The image above illustrates the setup where a TV is used. If a projector setup is to be used, replace the TV with a projector.

In this setup the computer must support a **video out** option so that the screen can be used as an additional screen connected to the computer during the calibration procedure. Additionally, the computer must have a **Video Capture Card** for recording the video signal coming in from the external device. For this setup you should use the **External Video** stimulus in Tobii Studio. An additional secondary monitor should be included for monitoring Tobii Studio during the recording. Configure Windows to use the TV or projector as the primary display. The TV or projector must be able to take in two different video signals, one from the computer (for calibration) and one from the external device used. You should be able to switch between the two video signals (computer video for calibration and external device when recording). Usually this is done by using the TV’s or projector’s remote control.

Remember to measure and add all the required parameters in the **X Configuration Tool**. Always measure the parameters relative to the **visible active area** of the TV or projector screen, where you can see the actual image. Read more about the tool in the previous chapters.
Parts and Controls

Equipment list

- Tobii TX300 Eye tracking unit
- Tobii TX300 stand
- Tobii TX300 foot
- Tobii TX300 Screen unit
- Tobii TX300 Top plate
- Allen wrench
- 10 x M4 Black screws
- Tobii Studio or Tobii T/X Series Eye Trackers Resources CD
- Tobii TX300 Tracker User Manual
- Tobii TX300 Assembly instructions
- Eye tracking unit power supply cable
- Screen unit power supply cable
- DVI-D cable (2.0 m)
- VGA cable (1.8 m)
- Audio Cable (3.5 mm, 1.8 m)
- LAN Cable (3.0 m)
- USB Cable A/B
- USB - LAN Adapter
- TX300 flight case
- Digital angle gauge
- Measurement tape

Front display

The Tobii TX300 consists of a screen unit and an eye tracking unit. The Tobii TX300 Eye Tracker has built-in speakers in the eye tracking unit and a user camera placed at the front in the screen unit. The control buttons for the display are located on the left side panel of the display. The system ON/OFF button for the eye tracker is located at the rear of the eye tracking unit.

Screen unit - Left side panel

Input image source and screen settings can be accessed on the panel located on the left side of the eye tracker.

- **Increase** - press to change the values on the on-screen selection menu
- **Decrease** - press to change the values on the on-screen selection menu
- **Up** - press to move on-screen selection
- **Down** - press to move on-screen selection
- **Menu** - press to access the screen settings Menu.
- **Source** - press to select source: Analogue (VGA connector input) or Digital (DVI connector input).
- **Stand By** - press for the monitor to enter in Standby mode.

Note: The Stand By button only controls the display. Pushing the Stand By button does not effect the eye tracker unit.
Rear panels

At the back of the TX300 the connections for the screen and the eye tracker can be found. The screen connectors are found at the back of the upper part of the screen. The connectors for the eye tracker are located at the back of the eye tracking unit.

Note: The Tobii TX300 comes with two power supplies; one is used for the screen and the other for the eye tracking unit.

Screen unit

The VGA/DVI display and power connections can be found at the rear panel of the screen.

USB connector for user camera - Connect to a USB port on your computer

Power connector - Connect to the power supply provided for the Tobii TX300 screen.

DVI connector - Connect to the digital video output (DVI) on your computer or video equipment. (Recommended)

VGA connector - Connect to the VGA output on your computer or video equipment. (Not Recommended)

Note: For optimal performance always use a DVI cable. (Using a VGA cable can affect image presentation timing).

Eye tracking unit

The power connector, network connection, sync-out port (not in use) and the trigger port can be found on the back of the eye tracking unit.

LAN connector - Connect to the eye tracker to your computer using a LAN cable.

System on/off button - Press the button once to turn on or off the eye tracker. The button will be illuminated when the system is active.

Audio in connector - Connect to the Audio out connector on your computer.

Power connector - Connect the power cable provided for the TX300 Eye Tracking unit.

Sync-out port - This connector is currently not in use.

Status indicators - The status indicators are used by the system to indicate its current status.

SMB Coaxial trigger port - Receives binary signals of 0 and 5 volt, 200mA, allows to connect the StimTracker unit to the Tobii TX300 Eye Tracker. Received triggers will appear on the following data sample.

Note: The system on/off button only controls the eye tracker. Pushing it does not affect the screen.
Customizing the Eye Tracker’s Display

**OSD menu**

The monitor settings can be adjusted on the on-screen display menu (OSD). To display the main OSD menu press the **Menu button** located on the left side of the eye tracker. For best results it is recommended that you turn on the monitor and wait for 30 minutes before making the adjustments.

**Navigating the menu**

Press the Menu button to display the main OSD menu on your screen. Use the **Up** and **Down** and **Menu buttons** to select the different sub-menus.

**Using the Menu, Up and Down buttons**

1. Display the main OSD menu. Press the **Menu button** to display the main menu on the screen.
2. Select the feature you want to adjust. Press the **Up** and **Down buttons** to display the desired sub-menu. Press the **Menu button** to select a sub-menu.
3. Adjust the menu. Press the **Up** and **Down buttons** to make the adjustment, then press **Menu button**. When you press the **Menu button** the settings are stored and the display returns to the previous menu.
4. Close the menu. Press the **Menu button** several times to exit the menu and return to normal viewing.

**Screen image Menu**

Press the **Menu button** to display the **Image menu**. Use the **Up** and **Down buttons** to navigate within the menu, and **Menu button** to select or change the settings.

- **Contrast**
  - Adjust distinction

- **Brightness**
  - Adjust the brightness of the screen (used to pwm control)

- **Color Mode**
  - Adjust color temperature and User RGB

- **Size**
  - Select display out

- **Auto Adjust**
  - Execute auto adjust for phase, clock, position and RGB color balance

**Color Temperature User Menu**

Press the **Menu button** to display the **Image menu**, then press use the **Up** and **Down buttons** to navigate to **Color Mode** and press the **Menu Button** to access the **Color Temperature Menu**.

- **Color Temp.**
  - Select various color temperature presets

- **User - R**
  - Adjust R value of the User color temperature

- **User - G**
  - Adjust R value of the User color temperature

- **User - B**
  - Adjust R value of the User color temperature
Screen Geometry Menu

Press the Menu button to display the Image menu. Use the Up and Down buttons to navigate within the menu and show the Geometry Menu.

H - Position
Adjust horizontal position of the screen

V - Position
Adjust vertical position of the screen

Clock
Adjust the clock of the screen

Phase
Adjust the phase of the screen

Pip (picture in picture) Menu

Press the Menu button to display the main menu. Use the Up and Down buttons to navigate within the menu and show the Pip Menu.

Multi Window
Select PIP or PBP

Input Source
Select multi window input source

Size
Select various screen sizes of PIP

Position
Select various screen positions of PIP

Swap
Swap main window and sub window

[Note]
1) This PIP function is optional.
2) Size and Position menu is available only to PIP function.

OSD (on-screen display) Menu

Press the Menu button to display the main menu. Use the Up and Down buttons to navigate within the menu and show the OSD Menu.

OSD Duration
Select OSD turn-off time

OSD H - Position
Adjust horizontal position of OSD

OSD V - Position
Adjust vertical position of OSD

OSD Halftone
Adjust OSD transparency level
System Menu
Press the Menu button to display the main menu. Use the Up and Down buttons to navigate within the menu and show the System Menu.

Mute
Adjust the audio volume mute on/off

Factory Reset
Rest to factory mode

Information Menu
Press the Menu button to display the main menu. Use the Up and Down buttons to navigate within the menu and show the Information Menu.

Main Mode
Information of the input source is displayed

Version
Firmware version is displayed.

Input Source Selection Menu
VGA (Not Recommended)
Video Graphics Array

DVI (Recommended)
Digital Visual Interface

VIDEO

SVIDEO
Seperate Video

COMPONENT
Summary of OSD menu when connected via DVI
Summary of OSD menu when connected via VGA

VGA

Image
- Contrast
- Brightness
- Color Mode
- Size
- Auto Adjust

Color Temp.
- Full
- 4:3
- 1:1

Normal
- Warm
- Cool
- sRGB
- User

User - R
User - G
User - B

Geometry
- H-Position
- V-Position
- Clock
- Phase

OFF
- PIP
- PBP

VGA
- DVI
- VIDEO
- SVIDEO
- COMPONENT

Small
- Middle
- Large

PIP
- Multi Window
- Input Source
- Size
- Position
- Swap

L-Up
L-Down
R-Down
R-Up

OSD
- OSD Duration
- OSD H-Position
- OSD V-Position
- OSD Halftone

Off
15
30
45
60

System
- Mute
- Factory Reset

Off
On

Information
- Information of the input source
- Version display

[Note]
Adjustment does not available.
Appendix I: 
Eye Tracker Upgrade

Eye tracker software upgrade

Follow the instructions below to upgrade the eye tracker software.

1. Open the Tobii EyeTracker Browser, found under Start > All Programs > Tobii.
2. In the Tobii EyeTracker Browser mark the eye tracker that is to be upgraded.
3. Click the Upgrade button.
4. Browse to the folder where the upgrade files are saved.
5. Select the upgrade file with the file extension .tobipkg and click OK.
6. A message stating that the upgrade is finished should appear. Click OK to close.
Appendix II: Troubleshooting Guide

At the back of the Tobii TX300 eye tracking unit two status indicator lamps can be found. Below is a table describing what the different codes mean and what should be done by the user when seeing a specific code.

<table>
<thead>
<tr>
<th>Red Lamp</th>
<th>Green Lamp</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>On</td>
<td>The eye tracking unit has been connected to a power source. This mode will only be displayed for a short while. If both lamps are on for more than 10 seconds contact Tobii Support.</td>
</tr>
<tr>
<td>Off</td>
<td>Blink</td>
<td>The eye tracking unit has been turned on; or the eye tracking unit firmware is being updated. This mode is displayed during the unit start up process. If the light continues to blink for a long period (&gt; 60 seconds) contact Tobii Support. During the firmware update this mode can be displayed for a longer time, depending on the size of the update.</td>
</tr>
<tr>
<td>Off</td>
<td>On</td>
<td>Eye tracking unit hardware is working normally. This mode is the normal mode for a working eye tracker.</td>
</tr>
<tr>
<td>Blink</td>
<td>Off</td>
<td>Internal technical error. Something within the eye tracker does not work as intended. Turn off the eye tracker by pressing the system ON/OFF button. Ensure that the eye tracker is off before proceeding, i.e. the blue light on the system ON/OFF button is out. Disconnect the power cable. Wait for about a minute. Connect the power cable and turn on the eye tracker again. If the eye tracker still blinks red, contact Tobii Support.</td>
</tr>
<tr>
<td>On</td>
<td>Off</td>
<td>Internal technical error. Something within the eye tracker does not work as intended. Turn off the eye tracker by pressing the system ON/OFF button. Ensure that the eye tracker is off before proceeding, i.e. the blue light on the system ON/OFF button is out. Disconnect the power cable. Wait for about a minute. Connect the power cable and turn on the eye tracker again. If the red lamp still turns on after starting the eye tracker, contact Tobii Support.</td>
</tr>
</tbody>
</table>

The Tobii TX300 Eye Tracker uses a network connection to communicate with the computer. The following chapters help you to troubleshoot the most common connection issues with your Tobii Eye Tracker.

Problems with the Apple Bonjour Service

The Apple Bonjour service is used by the Tobii Eyetracker Browser and Tobii Studio to identify the eye trackers that are connected to the same network as the computer. The service is installed automatically with Tobii Studio and the Tobii Eye Tracking Tools.

1. The Apple Bonjour Service is not installed on the computer.

Check if the service is installed on the computer:

Open the Windows Control Panel (Classic View in Windows Vista) > Administrative Tools > Services.

If the Apple Bonjour Service is not listed, then it will have to be installed on the computer. First check that either Tobii Studio or the Tobii Eye Tracking Tools are installed on the computer, open the All Programs folder in your Windows Start menu:

1. If a folder named Tobii containing the Tobii Eyetracker Browser is present in the All Programs folder, then at least one of the two is installed. If that is the case, download and install the latest version of the Apple Bonjour Service from: http://www.apple.com/support/downloads/bonjournforwindows.html

2. If the Tobii folder is missing from the All Programs folder, then re-install Tobii Studio or the Tobii Eyetracker Browser on the computer.
2. **The Apple Bonjour Service is installed but not started.**

Open the Windows **Control Panel** (Classic View) > **Administrative Tools** > **Services**.

Check in the **Services** list if the **Apple Bonjour Service's Status** is set to **Started**. If the **Status** is empty then right click on it and select **Start**. Restart any Tobii applications and connect again.

3. **The Apple Bonjour Service cannot be started.**

Most likely the service is blocked by an anti-virus software or Group Policy. Check any Group Policies and anti-virus software installed (not only running) on the computer. If you do not know how to do this, please contact your IT administrator as the procedure differs between security applications.

4. **The Apple Bonjour Service is up and running but there is still no connection.**

Check that the port Apple Bonjour Service uses to scan the network is not blocked by any firewall. It uses UDP port 5353. If you need help in doing this, please contact your IT administrator as the procedure for doing this differs between security applications.

5. **If none of the above works.**

If the computer is not connected to the Internet and Skype is running, Skype will flood all network connections in attempts to connect to the Skype servers. This can cause problems with the eye tracker connection. Turn off Skype.

6. **The eye tracker takes a long time to start tracking.**

If the eye tracker shows a delay of 10-30 seconds when showing the track status, starting a calibration or starting a recording, try to upgrade the Apple Bonjour Service to its most recent version (see point 1). Using an outdated version of the Apple Bonjour Service's may cause slow connection problems.

**Problems with the peer-to-peer network configuration**

When the eye tracker is connected directly to the test computer it uses a network connection with a DHCP server.

Check if the network card is set to obtain an IP address automatically (see the chapter ‘Setting up the network connection to the eye tracker in Windows’ chapter in this manual).
Appendix III: Specifications

Tobii TX300 Eye Tracker

The characteristics of an eye tracker can be described in terms of gaze accuracy and gaze precision. Accuracy describes the angular average distance from the actual gaze point to the one measured by the eye tracker. Gaze precision describes the spatial variation between successive samples collected when the subject fixates at a specific point on a stimuli. More information regarding the accuracy and precision measurements can be found in Appendix VI. A glossary can be found in Appendix V.

<table>
<thead>
<tr>
<th>Gaze accuracy (Firmware 1.0.7 measurements)</th>
<th>Monocular</th>
<th>Binocular</th>
</tr>
</thead>
<tbody>
<tr>
<td>At ideal conditions(^1)</td>
<td>0.5(^\circ)</td>
<td>0.4(^\circ)</td>
</tr>
<tr>
<td>At 25(^\circ) gaze angle</td>
<td>0.4(^\circ)</td>
<td>0.3(^\circ)</td>
</tr>
<tr>
<td>At 30(^\circ) gaze angle</td>
<td>0.8(^\circ)</td>
<td>0.6(^\circ)</td>
</tr>
<tr>
<td>At 1 lux</td>
<td>0.8(^\circ)</td>
<td>0.6(^\circ)</td>
</tr>
<tr>
<td>At 300 lux</td>
<td>0.5(^\circ)</td>
<td>0.4(^\circ)</td>
</tr>
<tr>
<td>At 600 lux</td>
<td>0.7(^\circ)</td>
<td>0.5(^\circ)</td>
</tr>
<tr>
<td>At 1000 lux</td>
<td>0.7(^\circ)</td>
<td>0.5(^\circ)</td>
</tr>
<tr>
<td>White stimuli background (300 lux)</td>
<td>0.8(^\circ)</td>
<td>0.6(^\circ)</td>
</tr>
</tbody>
</table>

\(^1\) Accuracy under ideal conditions is measured in the center of the head movement box with the subject fixed in a chinrest. Data is collected immediately after calibration, in a controlled laboratory environment with constant illumination, with 9 stimuli points at gaze angles of ≤18\(^\circ\).
## Gaze precision (Firmware 1.0.7 measurements)

<table>
<thead>
<tr>
<th></th>
<th>Monocular</th>
<th>Binocular</th>
</tr>
</thead>
<tbody>
<tr>
<td>With Stampe filter¹</td>
<td>0.01°</td>
<td>0.01°</td>
</tr>
<tr>
<td>Without filter</td>
<td>0.09°</td>
<td>0.07°</td>
</tr>
</tbody>
</table>

¹ Stampe (Behavior Research Methods, Instruments & Computers, 1993, 25 (2), pp.137-142) describes a noise reduction filter commonly used for eye tracking data. In these measurements, the Stampe stage 2 algorithm has been applied.

---

### Precision in Z-axis

![Precision in Z-axis graph](image)

### Eye tracking specifications (Firmware 1.0.7 measurements)

<table>
<thead>
<tr>
<th>Specification</th>
<th>Monocular</th>
<th>Binocular</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sampling</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sampling rate (binocular)</td>
<td>60Hz, 120Hz, 250Hz or 300 Hz</td>
<td></td>
</tr>
<tr>
<td>Sampling rate variability</td>
<td>0.3%</td>
<td></td>
</tr>
<tr>
<td>Latency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processing latency</td>
<td>1.0 - 3.3 ms</td>
<td></td>
</tr>
<tr>
<td>Total system latency</td>
<td>&lt;10 ms</td>
<td></td>
</tr>
<tr>
<td>Timestamp precision</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Via sync-out port</td>
<td>&lt;0.1 ms</td>
<td></td>
</tr>
<tr>
<td>As specified in each data sample</td>
<td>Std dev 40 µs</td>
<td></td>
</tr>
<tr>
<td>Time to tracking recovery</td>
<td></td>
<td></td>
</tr>
<tr>
<td>For blinks</td>
<td>Immediate</td>
<td></td>
</tr>
<tr>
<td>After lost tracking</td>
<td>10 - 165 ms</td>
<td></td>
</tr>
<tr>
<td>Head movement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freedom of head movement at 65 cm (width x height)</td>
<td>37 x 17 cm (15 x 7&quot;)</td>
<td></td>
</tr>
<tr>
<td>Operating distance (eye tracker to subject)</td>
<td>50-80 cm (20-31&quot;)</td>
<td></td>
</tr>
<tr>
<td>Max head movement speed</td>
<td>50 cm/s (20&quot;/s)</td>
<td></td>
</tr>
<tr>
<td>Max gaze angle</td>
<td></td>
<td>35°</td>
</tr>
<tr>
<td>Tracking technique</td>
<td></td>
<td>Dark pupil tracking</td>
</tr>
</tbody>
</table>

A glossary can be found in Appendix V.
The TX300 Eye Tracker is an integrated eye tracker with a removable 23" TFT monitor. Removing the TFT monitor transforms the integrated eye tracker into a standalone eye tracker.

### Screen unit

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen size</td>
<td>23&quot;</td>
</tr>
<tr>
<td>Screen resolution (Max)</td>
<td>1920 x 1080 pixel</td>
</tr>
<tr>
<td>Aspect ratio</td>
<td>16:9</td>
</tr>
<tr>
<td>Display colors</td>
<td>16.7 M (Hi-FRC)</td>
</tr>
<tr>
<td>Vertical Sync Frequency</td>
<td>49-75 Hz</td>
</tr>
<tr>
<td>Horizontal Sync Frequency</td>
<td>54.2-83.8 kHz</td>
</tr>
<tr>
<td>Response time</td>
<td>typical 5 ms</td>
</tr>
<tr>
<td>Luminance, white</td>
<td>typical 300 cd/m²</td>
</tr>
<tr>
<td>User Camera</td>
<td>Built in (640 x 480 @ 30fps)</td>
</tr>
<tr>
<td>Weight</td>
<td>4 kg (8.8 lbs)</td>
</tr>
<tr>
<td>Connectors</td>
<td>DVI/VGA</td>
</tr>
<tr>
<td></td>
<td>USB (User camera)</td>
</tr>
<tr>
<td></td>
<td>Power connector</td>
</tr>
</tbody>
</table>

### Eye Tracking unit

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eye tracking processing unit</td>
<td>Embedded</td>
</tr>
<tr>
<td>Speaker</td>
<td>3 W (mono)</td>
</tr>
<tr>
<td>Weight</td>
<td>6 kg (13.2 lbs)</td>
</tr>
<tr>
<td>Unit Size (without desk stand)</td>
<td>55 x 24 x 6 cm (22 x 9 x 2&quot;)</td>
</tr>
<tr>
<td>Connectors</td>
<td>LAN (TCP/IP over Ethernet - data samples)</td>
</tr>
<tr>
<td></td>
<td>12 pin connector (LVDS - sync out) (currently not in use)</td>
</tr>
<tr>
<td></td>
<td>3.5 mm audio plug (audio in)</td>
</tr>
<tr>
<td></td>
<td>SMB coaxial trigger port 5v, 200mA</td>
</tr>
<tr>
<td></td>
<td>Power connector</td>
</tr>
</tbody>
</table>
Appendix IV:
Bright Light Illumination Mode

Setup Instructions for Bright Light Illumination Mode

The Bright light illumination mode significantly improves the accuracy performance in the middle and the bottom part of the screen of the TX300. The mode also has an impact on the tracking robustness for subjects with large size pupils at close distance to the eye tracker or when performing recordings in complete darkness (1 lux) unless the eye tracker is set to operate in 250 Hz or lower. For optimal performance when using this mode it is recommended to set the eye tracker to operate in 250 Hz or lower.

1. **Open** the Tobii Eye Tracker Browser from **Start > All Programs > Tobii**.
2. In the Tobii Eye Tracker Browser mark the Tobii TX300 Eye Tracker.
3. **Choose** the option **Bright light** from the **Illumination Mode drop down menu**.
4. If you intend to use the eye tracker in a dark environment change the data rate to **250 Hz (or lower)** from the **Data Rate drop down menu** for optimal performance.
5. **Close** the Tobii Eye Tracker Browser window.
6. **Open** the Tobii EyeTracker Browser, found under

**Note:** Illumination mode settings are not persisted after restart of the Tobii TX300 Eye Tracker. Always set the illumination mode before starting a new study if the eye tracker has been turned off or after restarting the eye tracker.
## Appendix V: Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monocular/binocular</td>
<td>Monocular data shown is based on data from each eye individually. Binocular data is the average of the two eyes.</td>
</tr>
<tr>
<td>Gaze precision</td>
<td>Describes the spatial angular variation between individual and consecutive gaze samples. Gaze precision can be measured under various conditions. Gaze precision is sometimes also specified as 'spatial resolution'. For more details, see Appendix VI.</td>
</tr>
<tr>
<td>Gaze accuracy</td>
<td>Describes the angular average distance from the actual gaze point to the one measured by the eye tracker. Gaze accuracy can be measured under various conditions. For more details, see Appendix II.</td>
</tr>
<tr>
<td>Sampling rate</td>
<td>Number of data samples per second. The TobiiT/X Eye Trackers series have a stable data-rate of 60, 120 or 300 Hz; that is 60, 120 or 300 data samples per second are collected for each eye.</td>
</tr>
<tr>
<td>Sampling variability</td>
<td>Sampling variability specifies the maximum difference between the stated sampling rate and the actual sampling rate that can occur during an eye tracking test.</td>
</tr>
<tr>
<td>Processing latency</td>
<td>Describes the time required by the eye tracker processor to perform image processing and eye gaze computations.</td>
</tr>
<tr>
<td>Total system latency</td>
<td>The duration from mid-point of the eye image exposure, to when a sample is available via the API on the client computer (assuming a dedicated Gigabit Ethernet connection). This includes half of the image exposure time, plus image read-out and transfer time, processing time and time to transfer the data sample to a client computer.</td>
</tr>
<tr>
<td>Timestamp precision via sync-out port</td>
<td>The temporal deviation of the signal on the sync-out port relative to the beginning of the actual exposure of the eye image.</td>
</tr>
<tr>
<td>Timestamp precision as specified in each data sample</td>
<td>The temporal deviation of the timestamp in the data sample received by the client application. This includes any offset in the clock sync between the eye tracker processing unit and a typical client computer.</td>
</tr>
<tr>
<td>Time to tracking recovery for blinks</td>
<td>When a subject blinks, the eye tracker loses the ability to track eye gaze because the eye is covered by the eyelid. If the pupil is occluded for only a short period (a few hundred milliseconds), the system will regain tracking immediately when the pupil becomes visible again, but only if the subject has maintained approximately the same head position during the blink. Data during blinks are only lost when the pupil is occluded, i.e. during the eyelid movement itself or when the eye is closed.</td>
</tr>
<tr>
<td>Time to tracking recovery after lost tracking</td>
<td>An eye tracker working in a natural user environment may occasionally lose track of the subject's eyes, e.g., when the subject completely turns away from the tracker. If a period of a few hundred milliseconds elapses during which the eye tracker is unable to detect the eyes in close proximity to where they were last detected, the eye tracker will start searching for the eyes within the entire head movement box. The stated measurement is the typical time to tracking recovery in such a situation. If the eye tracker is unable to detect the eyes of the subject even after about one minute, the system will enter a &quot;slow search&quot; mode, leading to larger recovery times.</td>
</tr>
<tr>
<td>Freedom of head movement</td>
<td>Describes an area (height × width in cm) where at least one eye is within the eye tracker's field of view.</td>
</tr>
<tr>
<td>Operating distance</td>
<td>Describes the minimum and maximum distances between the subject's eyes and the surface covering the eye tracker sensors at which eye tracking can be done while maintaining robust tracking.</td>
</tr>
<tr>
<td>Max head movement speed</td>
<td>Describes the maximum head movement speed allowed while maintaining robust tracking. The specified number is for sideways head movement.</td>
</tr>
<tr>
<td>Max gaze angles</td>
<td>The maximum gaze angle for which the eye tracker can perform robust and accurate tracking on both eyes. The gaze angle is the angle ABC with A = center of the eye tracker (midpoint between the two eye tracking sensors), B = eye position (midpoint between the left and the right eye) and C = stimuli point.</td>
</tr>
<tr>
<td>Eye tracking technique</td>
<td>Tobii Eye Trackers use two different techniques to determine eye position: 1. Bright pupil eye tracking, where an illuminator is placed close to the optical axis of the imaging device, causing the pupil to appear lit up (the same phenomenon that causes red eyes in photos). 2. Dark pupil eye tracking where the illuminator is placed away from the optical axis, causing the pupil to appear black.</td>
</tr>
<tr>
<td>Eye tracking processing unit</td>
<td>Gaze data calculations are performed by firmware embedded in the eye tracker. Different applications can be connected over a LAN connection as clients to the eye tracker system to gather eye gaze data and other data in real-time, perform calibrations, etc.</td>
</tr>
</tbody>
</table>
Appendix VI: Measurements

**Accuracy and precision measurements**

Gaze accuracy and precision are typically measured in degrees of visual angle. One degree accuracy corresponds to an average error of 12 mm (0.47") on a screen at a distance of 65 cm (27"). Data is presented as monocular or binocular. Monocular data is based on data from the subject's dominant eye only. Binocular data is the average of both eyes.

**Gaze precision**

Precision measurements are done using artificial eyes to eliminate artifacts from human eye movements. Tobii specifies precision both with and without noise reduction filters. All measurements are done at the default sampling rate of the eye tracker and at the optimum distance between the eye tracker and the subject. For TX300, the sampling rate was 300 Hz and the distance 65 cm (27"). Precision is calculated as root-mean-square (RMS) of successive samples.

Using a noise reduction filter can improve precision and it is often used when doing eye tracking analysis. For comparison, Tobii provides precision values both with and without applying a filter. The filter used is a Stampe stage 2 algorithm. More information about this filter can be found in Behavior Research methods, Instruments & Computers 1993, 25 (2), pp. 137-142.

As the distance from the eye tracker influences precision, measurements are also taken at various distances. Data from these measurements is binocular.

**Gaze accuracy**

Accuracy under ideal conditions is measured in the center of the head movement box with the subject fixed in a chinrest. Data is collected immediately after calibration, in a controlled laboratory environment with constant illumination, with 9 stimuli points at gaze angles ≤18°. Measurements are done on 20 test subjects without lenses, glasses or droopy eyelids. Accuracy for one subject is calculated as the mean of several data samples for several stimuli points across a screen. The accuracy figure presented is the mean accuracy from all subjects.

Good accuracy is difficult to achieve at large gaze angles, but is important when testing large stimuli. For instance, the upper corner of a 23" screen with the test subject at a distance of 65 cm (27") from the eye tracker corresponds to a 31° visual angle from the center of the eye tracker unit. Consequently, measurements are also presented for stimuli presentations at large gaze angles.

When luminance of the stimuli or the illumination in the lab changes, the size and shape of the pupil is affected. Unless compensated for, this may cause a significantly reduced accuracy. Testing the influence of surrounding light and stimuli luminance on accuracy is done in a laboratory environment with controlled light conditions. Stimuli points are presented on a black background so as not to influence ambient light conditions. Testing is also done with ambient light at a level deemed ‘normal’ office lighting where the background is changed to white with black stimuli points. In previous technical specifications, for Tobii products the results from a test in which the background was changed has been referred to as Drift.

As with precision, the distance from the eye tracker influences accuracy. When testing this influence, calibration is done with the subject in the center of the head movement box (i.e. at a distance of 65 cm) and measurements are made thereafter. Measurements are performed with the test subject at precise and specific distances relative to the eye tracker, measured along the axis of the tracking sensors. Data from these measurements is binocular.
## Appendix VII: Data sample output

### Eye tracker data sample output

Different applications can be connected as clients to the eye tracker to, e.g., gather eye gaze data in real-time and perform calibrations. Applications that can be used together with the eye tracker include the Tobii Studio software, third party software products, or your own custom software based on the Tobii Software Development Kit. For more information about the supported software products please refer to the product descriptions and documentation for the respective products.

Below is a summary of the data that the eye tracker outputs. Please note that the parameter names, definitions and coordinate systems may differ depending on the software used, please refer to the software documentation for additional information.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Timestamp</strong></td>
<td>Timestamp in microseconds from the eye tracker's internal clock. Additional timestamps are available in Tobii Studio.</td>
</tr>
<tr>
<td><strong>Gaze Point Left X, Y</strong></td>
<td>Horizontal (X) and vertical (Y) coordinates of the gaze point for the left eye. Available in different coordinate systems in Tobii Studio and the Tobii Software Development Kit.</td>
</tr>
<tr>
<td><strong>Eye Position Left X, Y, Z</strong></td>
<td>The 3D position of the left eye in relation to the eye tracker. Available in different coordinate systems in Tobii Studio and the Tobii Software Development Kit.</td>
</tr>
<tr>
<td><strong>Pupil Diameter Left</strong></td>
<td>Estimated diameter of the left eye pupil in millimeters.</td>
</tr>
<tr>
<td><strong>Validity Code Left</strong></td>
<td>Indicates the confidence level that the left eye has been correctly identified by the eye tracker.</td>
</tr>
<tr>
<td><strong>Gaze Point Right X, Y</strong></td>
<td>Horizontal (X) and vertical (Y) coordinates of the gaze point for the right eye. Available in different coordinate systems in Tobii Studio and the Tobii Software Development Kit.</td>
</tr>
<tr>
<td><strong>Eye Position Right X, Y, Z</strong></td>
<td>The 3D position of the right eye in relation to the eye tracker. Available in different coordinate systems in Tobii Studio and the Tobii Software Development Kit.</td>
</tr>
<tr>
<td><strong>Pupil Diameter Right</strong></td>
<td>Estimated diameter of the left eye pupil in millimeters</td>
</tr>
<tr>
<td><strong>Validity Code Right</strong></td>
<td>Indicates the confidence level that the right eye has been correctly identified by the eye tracker.</td>
</tr>
</tbody>
</table>
Appendix VIII: Data sample rate

**Changing the data sample rate.**

To change the data sample rate you can click on the data rate drop down **Data Rate Menu** located within the Tobii Eye Tracker Browser and select the appropriate rate for your study from the choices of 60Hz, 120Hz, 250Hz or 300Hz.

The **Data Rate** preference is stored on the TX300; always make sure to verify your **Data Rate** before gathering data.
Appendix IX: Infant Illumination mode

What is Infant Illumination Mode and how to turn it on.

The new illumination mode, implemented in the Tobii TX Firmware 1.0.2 and Tobii EyeTracking Tools 2.4.11 releases, enables the user to select an Infant Illumination Mode that improves the tracking robustness of the Tobii TX300 Eye Tracker with infants.

Warning: This mode should only be used if the user can’t track infants. Enabling the Infant Illumination Mode impacts the general tracking performance.

To enable the Infant Illumination Mode:

1. Open the EyeTracker Browser, found under Windows Start button > All Programs > Tobii, and select a Tobii TX300 Eye Tracker.

   Note: If the eye tracker is running an old firmware version (1.0.1 or lower) the Illumination mode button will remain disabled.

2. Click on the Illumination mode button and select Infant.

3. Read the disclaimer, Click OK to confirm and accept your change or Cancel to reject the change.

4. The information that the eye tracker is set to the Infant Illumination Mode will be displayed on the EyeTracker Browser window.

5. To disable the infant Illumination mode repeat steps 1 to 3. In step 2 select Default instead of Infant then click OK to accept the changes.

   Note: When you power off the eye tracker the Illumination mode will revert automatically to the default setting.